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WELCOME TO MISSION TRACKING 
Welcome 

The Subsistence Planning Integration Data Enterprise Readiness System (SPIDERS) is a planning 
tool designed to help DLA assess the ability of private industry to meet warfighters’ demands in a 
surge situation. Demand surge situations occur during major regional conflicts (e.g., Operations 
Desert Shield and Desert Storm), humanitarian assistance missions, and domestic or foreign 
natural disaster relief. 

 

The Mission Tracking application is a module within the SPIDERS system that is used to track 
shipments of Operational Rations required by customers (services).  Ongoing Missions (forward 
positions) regularly provide requirements for Subsistence materiel.  These requirements are 
received by DSCP, ordered, booked and tracked from Vendor to Container to ultimate delivery 
destination.  The Mission Tracking tool assists the DSCP in managing, tracking and monitoring 
the status of these customer requirements.  This enables the DSCP to better serve their customers 
as well as measure the overall process to identify bottlenecks and apply process improvements to 
shorten overall customer delivery cycles. 
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GETTING STARTED 
Starting the Mission Tracking Application 

To use the Mission Tracking application, you must first have a SPIDERS user account; this user 
account must be authorized for Mission Tracking.   

The only software that must be installed on your computer is a Web browser (e.g., Microsoft 
Internet Explorer) and the Citrix plug-in. Both of these are part of the standard desktop suite for 
DSCP and may already be installed on your computer. 

To start Mission Tracking, follow these steps: 

• Visit the SPIDERS Home Page using your Web Browser. 

• Login to SPIDERS using the username and password supplied to you for the SPIDERS 
application. 

• Launch Mission Tracking by clicking on the Mission Tracking link on the left Navigation Panel. 

Visit the SPIDERS Home Page 
• From a Web browser (e.g., Microsoft Internet Explorer), enter the following URL to reach the 

DLA Today & Tomorrow web site:  https://today.dla.mil/j-3/ibms 

• To reach the SPIDERS Home Page, click on the SPIDERS tab. 

 
• Click on the My SPIDERS Login 

 
• This will bring you to the SPIDERS Home Page 
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See Also 
Login to SPIDERS  

Login to SPIDERS 
From the SPIDERS Home Page, click on "My SPIDERS Login" in the Home Menu on the left.  
Enter the username and password supplied to you for the SPIDERS application. This will bring 
you to your personal SPIDERS Home Page.    

 
 

See Also 
Launch Mission Tracking  
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Launch Mission Tracking 
To start the Mission Tracking Application, click either of the "Mission Tracking" links: 

• From the Navigation Panel  on the left. Note that the list of functions available in the Home Menu 
may be different for you, depending on your role and privileges. If you do not see Mission 
Tracking listed in the Home Menu, contact the DSCP Mission Tracking support POC. 

 
• Or select from the Menu on the right 

 
Mission Tracking will launch as a desktop application using the Citrix plug-in.  

NOTE: For security reasons, your Citrix session will time-out after an extended period of 
inactivity. If you do not use Mission Tracking for 60 minutes, the application will be closed 
automatically. If you have not saved a record you are editing, these changes will be lost.  

Ending Your Mission Tracking Session 
To close the Mission Tracking application, select "Exit" under the File menu bar option. You may 
also simply close the application window. If you are in a data editing window and have unsaved 
record changes, Mission Tracking will prompt you to save the record before exiting. 

NOTE: Exiting from Mission Tracking does not end your SPIDERS session. To end your 
SPIDERS session, select "Logoff" from the SPIDERS Main Menu Bar. 
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MISSION TRACKING BASICS 
Data Views 

There are five types of Mission Tracking data that you can view or modify: 

• Missions  

• Requirements 

• Orders 

• Bookings 

• Containers  

There is a natural association among this data: 

 
• A Mission is a forward position that generates one or more sets of Requirements for subsistence 

materiel. 

• One or more Requirements are established for each Mission, defining the types of rations to be 
ordered and shipped to the Mission location. 

• One or more Orders are created as items are ordered to satisfy the Mission requirements.  

• Bookings are created as arrangements are made to ship rations to their destinations.  

• Orders are associated with Bookings to indicate how the item will be transported. Because of 
quantity, an order may need to be associated with multiple Bookings. 

• One or more Containers are associated with a Booking indicating on which vessel the container 
will be transported. It may take several containers to hold all of the items being shipped on a 
vessel.  Each Container can have a Packing List identifying the items and their quantity placed 
within the container.  

 

Data Selection Windows 
Data Selection windows allow you to review a list of records of a particular Data View (e.g., 
Missions, Orders, etc.).  From these windows you are able to: find records, edit records and create 
new records. 
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Overview 

 
 

• Title Bar — The title bar displays the name of the application. Of greater interest, the title bar 
displays the Data View that is currently active (e.g., Missions, Orders, etc.). 

• Menu Bar — All of the functions available on the Toolbar and Action Bar are available as menu 
selections here. In addition, additional features such as Reports are available only through the 
Menu Bar. 

• Toolbar — Buttons on the Toolbar allow you to switch between different Data Views and to 
change the content of the data selection grid via the search capability. These functions apply to the 
Data Selection Grid as a whole. 

• Data Selection Grid — This section of the window displays the records that match the data 
selection criteria you have specified. The grid does not show all of the fields associated with a 
record, just enough for you to identify the record in which you are interested. Use your cursor to 
select the record you wish to take action on. The record that is highlighted is the "active record". 

• Action Bar — The functions on the Action Bar apply to the active record in the Data Selection 
Grid: editing a record, creating a "child" record or navigating to a related Data View. 

• Status Bar — Information on the status bar identifies the active record in the Data Selection Grid. 
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Finding Records 
By default, a Data Selection window will list all of the records of a particular type. For example, 
clicking on the Mission Data View button displays all Mission records in the Data Selection Grid. 

To find the specific record(s) in which you are interested, you have the option to scroll down 
through the list. For a short list (such as Missions), this may not present a problem. But when 
combined with the Search capability, Data Selection windows provide a very useful way for you 
to quickly locate the subset of data that you want. For example: 

• Locate the orders that have not yet been booked 

• Find the bookings for a specific Ship To DODAAC 

When combined with the Navigation capability, Data Selection windows provide another way to 
locate the subset of data that you want. For example: 

• Find all of the Requirements for a Mission 

• Find all of the Containers for a Booking. 

Editing Records 
When you find a record that you want to view or modify, place your cursor on that row in the data 
selection grid to make that the "active" record. Then click the "Edit" button on the Action Toolbar; 
or simply double-click on the active record. This will bring up the appropriate Data Editing 
window for the record you selected. 

Creating New Records 
For the Missions and Bookings Data Views, use the "New" button on the Action Bar to create new 
records. For all other Data Views, you will need to create new records from the "parent" Data 
View.  

 

Data 
View 

Create 
New? 

Create Related Data 
Views 

Missions Yes Requirements 

Require
ments 

 Orders 

Orders  Bookings 

Booking
s 

Yes Containers 

Containe
rs 

 n/a 
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See Also 
Missions Data Selection Window  

Requirements Data Selection Window  

Orders Data Selection Window  

Bookings Data Selection Window  

Containers Data Selection Window  

 

Navigating 
Mission Tracking is designed to allow you to quickly find records that are associated. Both Data 
Selection windows and Data Editing windows feature a "Go To" button on the Action Bar that 
allow you to navigate to Data Views that are related to the active record. 

 

 
 

Data 
View 

Go To 

Missions • Requirements 

Require
ments 

• Missions 

• Orders 

Orders • Missions 

• Requirements 

• Bookings 

Booking
s 

• Missions 

• Requirements 

• Orders 

• Containers 

Containe • Missions 
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Data 
View 

Go To 

rs • Requirements 

• Orders 

• Bookings 

 

Searching 
The search capability of each Data Selection window allows you to specify which records are 
displayed in the Data Selection Grid. This provides a way to quickly find a record to view/edit and 
eliminates scrolling through records in the Data Selection grid. 

 
The three search-related buttons on the Toolbar provide these capabilities: 

• Search — Brings up the search criteria dialog for the current Data View. The result of a search is 
to display a specific subset of records in the data selection grid. 

• Clear All — Clears all records displayed in the data selection grid.  

• Show All — Displays all of the records for the Data View in question (i.e., displays all Missions, 
all Requirements, etc.) 

 

Each Data Selection window offers different search criteria specific to each Data View. However 
there are three basic strategies for filtering records. The examples below are taken from the 
Missions search dialog, 

• Return a set of related records — You can return all Missions for the same paying service. 

• Return a set of similar records — You can return all Missions that have a particular word or group 
of words in the Mission description. 

• Return a single record — You can return a specific Mission if you know a value that uniquely 
identifies the record (in this case, the Mission ID). 

 
 

Data Editing Windows 
A Data Editing window allows you to edit one record from a particular Data View (e.g., Missions, 
Requirements).  
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Data Editing Window Overview 

 
 

• Title Bar — The title bar displays the name of the application. Of greater interest, the title bar 
displays the Data View that is currently active (e.g., Missions Details, Orders Details, etc.). 

• Menu Bar — All of the functions available on the Toolbar and Action Bar are available as menu 
selections here. In addition, additional features such as Reports are available only through the 
Menu Bar. 

• Toolbar — Buttons on the Toolbar allow you to switch between different Data Views. When 
editing a record, the search capability is disabled.  

• Data Editing Area — This section of the window displays the fields for the active record in from 
the Data Selection grid. Within a Data Editing area, you will be able to see all of the fields for a 
record. 

• Action Bar — The functions on the Action Bar apply to the record being editing: save/cancel the 
editing actions, create a "child" record or navigate to a related Data View. 

• Status Bar — Information on the status bar provides information about the record being edited. 
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Editing Records 
The data editing area displays all of the detailed information for the active record in the Data 
Selection grid. The layout of the editing area is distinct for each Data View but follows similar 
conventions: 

• Editable Record Information — Those fields with white data-entry fields denote the fields that are 
available for you to edit. If the label is marked with a red asterisk, a value must be supplied for 
that field. 

• Tabs — Note that the Data Editing area may use several tabs to contain all of the data for a record.  
For example, the Container Data Editing area contains three tabs (Container Info, Packing List 
Detail and Packing List Info). 

• Related Data Information — Often it is valuable to be able to view related information, even 
though it is not from the record in question. For example, the Requirement Data Editing area 
displays the ID and name of the related Mission. The Order Data Editing area displays the full 
description of the item being ordered. These fields are displayed against a grey background and 
cannot be modified. 

• Non-Editable Record Information — Some record fields are system-generated. For example, the 
Mission ID, Requirement ID and Order ID are supplied for you but are important to know. These 
fields are displayed against a grey background and cannot be modified. 

 

 

Creating New Records 
Use the "Save & New" button on the Action Bar to create new records for the same Data View. 
For all Data Views except Containers, you also have the ability to create new records for related 
Data Views. 

 

Data 
View 

Create 
New? 

Create Related Data 
Views 

Missions Yes Requirements 

Require
ments 

Yes Orders 

Orders Yes Bookings 

Booking
s 

Yes Containers 
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Data 
View 

Create 
New? 

Create Related Data 
Views 

Containe
rs 

 n/a 

 

See Also 
Missions Data Editing Window  

Requirements Data Editing Window  

Orders Data Editing Window  

Bookings Data Editing Window  

Containers Data Editing Window  

 

Reports 
There are six selections available under the Reports option on the Mission Tracking Menu Bar. 
Four of these selections produce formatted output that is viewed using the Crystal Reports viewer. 
The other two reports create Excel spreadsheet files. 

  

Report T
y
p
e 

Purpose 

Bookings Report C
r
y
s
t
a
l 

Displays all containers for a selected 
booking 

Document Number Report C
r
y
s
t
a
l 

Display all containers for a selected 
document number 

Container TCN Report C
r
y
s
t
a
l 

Displays all containers for a selected 
TCN 

Container Receipt Report C
r
y
s

Displays all containers for a selected 
Mission 
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Report T
y
p
e 

Purpose 

t
a
l 

Container Status by Mission 
Spreadsheet  

E
x
c
e
l 

Displays all items not received for a 
Mission 

Container & Contents Receipt 
Spreadsheet  

E
x
c
e
l 

Lists all items shipped for a Mission to 
date 
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WINDOWS REFERENCE 
Missions 
Missions Data Selection Window 

Search Criteria 
Columns Displayed:  Paying Service, Mission ID, Name Keyword, Description Keyword 

 
Data Selection Grid 
Columns Displayed: Mission ID, Mission Name 

Action Bar Functions 
 

Action Bar 
Function 

Description 

New Create new Mission record 

Edit View details of active record in the data selection grid 

Go To Navigate to the Data Selection window for the following data 
views that are related to the active record: 

• Requirements 

New (related data 
view) 

Navigate to a Data Editing window for the following data views 
that are related to the active record. 

• Requirements 

 

Missions Data Editing Window 
Record Actions 

• Save 

• Cancel 

• Save and create another new Mission 

• Save and create a new Requirement for this Mission 
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Record Navigation 
• Go to Requirements for selected Mission 

Data Fields 
 

Data 
Field 

Req
uire

d 

Comment 

Mission 
ID 

 Non-editable. System-
generated 

Paying 
Service 

* Select from:  

• Air Force 

• Army 

• DLA 

• Marine Corp 

• Other 

Name *  

Descriptio
n 

*  

 

Requirements 
Requirements Data Selection Window 

Search Criteria 
Columns Displayed:  Requirement ID, Mission ID/Name, Requisitioner DODAAC, Required 
Delivery Date 
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Data Selection Grid 
Columns Displayed: Mission ID, Requirement ID, DODAAC, Required Delivery Date  

Action Bar Functions 
 

Action Bar 
Function 

Description 

Edit View details of active record in the data selection grid 

Go To Navigate to the Data Selection window for the following data 
views that are related to the active record: 

• Missions 

• Orders 

New (related data 
view) 

Navigate to a Data Editing window for the following data views 
that are related to the active record. 

• Orders 

 

Requirements Data Editing Window 
Record Actions 

• Save 

• Cancel 

• Save and create another new Requirement for the same Mission 

• Save and create a new Order for this Requirement 

• Record Navigation 

• Go to Mission for selected Requirement 

• Go to Orders for selected Requirement 

• Data Fields 

 

Data Field Req
uire

d 

Comment 

Requirement ID  Non-editable. System-generated 

Requisitioner DODDAC *  

Required Delivery Date * MM/DD/YYYY format 

Requirement *  

Requisitioner POC   

Ship To POC   

   

Ship To DODAAC  The DODAAC for the location of 
the shipment. 

Enter either the Ship To DODAAC 
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or the Ship To Address 

Ship To Address  The postal location for the shipment. 

Supplementary Address 
DODAAC 

 Enter either Supplementary 
DODAAC or Supplementarry 
Address 

Supplementary Address   

Median Status   

Demand Code   

Project Code   

Advice Code   

Ownership Purpose   

Comments   

Tabs: 
1  Requirement Info 

2  Shipping Info and Comments 

Additional Information Displayed for Informational Purposes 
 

Data 
Field 

Mission 
ID 

Mission 
Name 

 

Orders 
Orders Data Selection Window 

Search Criteria 
Columns Displayed: Document Number, NSN, Requisitioner DODAAC, Required Delivery 
Date, Unbooked Items 
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Data Selection Grid 
Columns Displayed: Mission ID, Requirement ID, Order ID, Document Number, Order Qty, 
NSN, Nomenclature, Requisitioner DODAAC, RDD, Ship To DODAAC 

Action Bar Functions 
 

Action Bar 
Function 

Description 

Edit View details of active record in the data selection grid 

Go To Navigate to the Data Selection window for the following data 
views that are related to the active record: 

• Missions 

• Requirements 

• Orders 

New (related data 
view) 

Navigate to a Data Editing window for the following data views 
that are related to the active record. 

• Bookings 

 

Orders Data Editing Window 
Record Actions 

• Save 

• Cancel 

• Save and create another new Order for the same Requirement 

• Save and create a new Booking; associate the new Booking with this Order 
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Record Navigation 

• Go to Mission for selected Order 

• Go to Requirement for selected Order 

• Go to Bookings for selected Order 

 

Data Fields 
 

Data 
Field 

Req
uire

d 

Comment 

Order  ID  Non-editable. System-generated 

Document 
Number 

* Duplicate document numbers are not allowed for 
operational ration orders 

NSN *  Enter the NSN without dashes. 
 
As you place orders, Mission Tracking will learn which 
NSN's you use. To speed data entry, those NSN's will be 
available to you in the drop-down list for this field. 

Quantity *  

Fund 
Code 

*  

Signal 
Code 

* Select from drop-down list of values. 

SNS * Select from drop-down list of values. 

Priority 
Code 

* Select from drop-down list of values. 

 

Additional Information Displayed for Informational Purposes 
 

Data Field 

Mission ID 

Mission Name 

Requirement ID 

Requisitioner 
DODDAC 

Required Delivery 
Date 

Requirement 
Description 

Item Weight 

Item Unit of Issue 
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Data Field 

NSN Description 

 

Bookings 
Bookings Data Selection Window 

Search Criteria 
Columns Displayed: Booking Number, Carrier, Vessel, Ship To DODAAC, Status 

 
 

Data Selection Grid 
Columns Displayed: Requirement ID, Order ID, Booking Number, Vessel Booked, Point of 
Embarkation, Ship To DODAAC, Sail Date 

Action Bar Functions 
 

Action Bar 
Function 

Description 

New Create new Mission record 

Edit View details of active record in the data selection grid 

Go To Navigate to the Data Selection window for the following data 
views that are related to the active record: 

• Missions 

• Requirements 

• Orders 

• Containers 
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Action Bar 
Function 

Description 

New (related data 
view) 

Navigate to a Data Editing window for the following data views 
that are related to the active record. 

• Containers 

 

Bookings Data Editing Window 
Record Actions 

• Save 

• Cancel 

• Save and create another new Booking for the Order selected on the Associated Missions, 
Requirements and Orders Tab 

• Save and create a new Container; associate the new Container with this Booking 

See Also: Associating an Order with A Booking  

 

Record Navigation 
• Go to the Order selected to view this Booking record. For example, you selected a Booking record 

for a specific Order Id in the Booking Data Selection window and then clicked the "Edit" button.  
Or you clicked the "Create New Booking" button from a Order Data Editing Window. For 
reference purposes, this Order Id is always visible in the Record Identifiers field of the Status Bar. 

• Go to Mission for the Order selected to view this Booking record (as described above). 

• Go to Requirement for the Order selected to view this Booking record (as described above). 

• Go to Containers associated with the selected Booking 

 

Data Fields 
 

Data Field Req
uire

d 

Comment 

Booking Number *  

Carrier *  

Vessel Booked *  

Sail Date  MM/DD/YYYY format 

Point of 
Embarkation 

* Code indicating the location that the 
shipment started. 

Point of 
Debarkation 

* Code indicating the location that the 
shipment ended. 

Estimated Time of 
Arrival 

* MM/DD/YYYY format 

Actual Delivery 
Date 
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Data Field Req
uire

d 

Comment 

Status  Select from drop-down list of values. 

Status Details   

Ship To DODAAC   

Tabs: 
1  Booking Info 

Additional Information Displayed for Informational Purposes 
 

Data Field 

Mission ID 

Mission Name 

Requirement 
ID 

Order ID 

Document 
Number 

RDD 

Order Quantity 

NSN 
Description 

2  Associated Missions, Requirements and Orders 

 

Associating An Order with a Booking 
If you created a Booking from an Order record (by using the New Booking feature in the Order 
Data Editing window), the Booking is already associated with one Order Id. However Bookings 
are normally associated with multiple Orders. The following procedure is used to associate other 
Orders when editing a Booking. 

• Select the "Associated Requirements, Missions and Orders Info Tab" 

• Click the "Add Row" button. 

• A pop-up list of Orders will appear at the bottom of the data grid.  

• If you decide not to select an order, click the mouse anywhere on the top data grid (showing the 
Associated Orders). 

• To select an Order, click once on the appropriate row in the pop-up list. Note that this pop-up list 
has its own scroll-bar to review the available orders. 
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• To break the association between an Order and a Booking, select the appropriate Order in the data 

grid and click the "Delete Row" button. Note that Order itself is not deleted; only the association is 
removed. 

 

Containers 
Containers Data Selection Window 

Search Criteria 
Columns Displayed:  Booking Number, Container Number, Container TCN, Document Number  

 
Data Selection Grid 
Columns Displayed: Booking Number, TCN, Vessel Shipped, Container Number, Estimated 
Time Of Arrival, Ultimate Destination Date Received 

 

Action Bar Functions 
 

Action Bar 
Function 

Description 

Edit View details of active record in the data selection grid 

Go To Navigate to the Data Selection window for the following data views 
that are related to the active record: 

• Missions 
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Action Bar 
Function 

Description 

• Requirements 

• Orders 

• Bookings 

 

Containers Data Editing Window 
Record Actions 

• Save 

• Cancel 

• Save and create another new Container for the same Booking 

See Also: Creating a Packing List  

Record Navigation 
• Go to Mission  

• Go to Requirement 

• Go to Orders 

• Go to the Booking associated with the selected Container 

Data Fields 
 

Data Field Req
uire

d 

Comment 

Container TCN *  

Container Number   

RF Tag ID   

Ultimate 
Destination Date 
Received 

 MM/DD/YYYY format 

Contents *  

   

Order ID/NSN  Not Editable 

Item Quantity  Number of units being shipped. 

The sum of an item's quantity across all 
containers cannot exceed the order 
quantity 

   

Invoice Number   

Ship To DODAAC   

Vessel Shipped   

 11



Data Field Req
uire

d 

Comment 

Total Number of 
Units 

  

Packing List Date   

Purchase Order   

Ship To Address   

Vansize   

Seal Number   

RDD Julian Date  In julian date format the date that the 
shipment is needed to arrive by. 

Sail Date  MM/DD/YYYY format 

SCAC   

TAC   

POE Code   

POD Code   

Gross Weight   

Cubic Feet   

Temperature   

 

Tabs: 
1  Container Info 

2  Packing List 

3  Packing List Info 

 

Additional Information Displayed for Informational Purposes 

Data Field 

Booking Number 

Booking Point of 
Embarkation 

Booking Point of 
Debarkation 

Document Number 

NSN Description 
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Creating a Packing List 
The following procedure is used to create a packing list for a Container: 

• Select the "Packing List Tab" 

• Click the "Add Row" button. 

• A drop-down list of Document Numbers will appear at the left of the data grid.  

• If you decide not to select an order, click the mouse anywhere on the tab away from the drop-
down list. 

• To select an Order, click once on the appropriate row in the drop-down list. Note that this drop-
down list has its own scroll-bar to review the available orders that you can select from. 

• By default, the total quantity ordered for the item will appear in the packing list. If the container 
represents a partial shipment, select the Order in the data grid and click the "Edit Quantity" button. 

• To drop an item from a packing list, select the appropriate Order in the data grid and click the 
"Delete Row" button. Note that Order itself is not deleted; only the association is removed. 
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REPORTS REFERENCE 
Bookings Report 
Purpose 
Displays all containers for a selected booking 

 

Selection Parameters 
• Mission ID 

• Starting RDD — Optional. Allows you to exclude requirements for previous years. 

 

Layout 
Header 

• Mission Id 

• Mission Name 

• Report Body 

• Requirement ID 

• RDD 

• Requisitioner DODAAC 

• Item NSN 

• Item Serial Number 

• Item Nomenclature 

• Item Quantity 

• Booking Number 

• Vessel Name 

• Sail Date 

• ETA 

• Booking Status 

• Container TCN 

• Sorted By 

• Requirement ID 

• NSN 
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Document Number Report 
Purpose 
Display all containers for a selected document number 

Selection Parameters 
• Container TCN 

 

Layout 

Header 

• Mission Id 

• Mission Name 

• Report Body 

• Requirement ID 

• RDD 

• Requisitioner DODAAC 

• Item NSN 

• Item Serial Number 

• Item Nomenclature 

• Item Quantity 

• Booking Number 

• Vessel Name 

• Sail Date 

• ETA 

• Booking Status 

• Container TCN 

 

 2



Container TCN Report 
Purpose 
Displays all containers for a selected TCN 

Selection Parameters 
• Container TCN 

 

Layout 
Header 

• Mission Id 

• Mission Name 

• Report Body 

• Requirement ID 

• RDD 

• Requisitioner DODAAC 

• Item NSN 

• Item Serial Number 

• Item Nomenclature 

• Item Quantity 

• Booking Number 

• Vessel Name 

• Sail Date 

• ETA 

• Booking Status 

• Container TCN 

 

Container Receipt Report 
Purpose 
Displays all containers for a selected Mission 

Selection Parameters 
• Mission 

• Starting RDD — Optional. Allows you to exclude requirements for previous years 
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• Days Since Container Received — This parameter allows you select containers based on the data 
received 

Containers that have been received in 
the last: 

All Containers 

1-30 days All received containers 

1-60 days All containers that have not been received 

1-90 days All containers, regardless of date received 

 

 
 

Layout 
Header 

• Mission Id 

• Mission Name 

• Report Body 

• Requirement ID 

• RDD 

• Container Number 

• ETA 

• Received Date 

• Days Since Required 

• Booking Number 

• POD 

• Contents 

• Carrier Name 

• Vessel Name 

• Container TCN 

• Total Quantity of Items in Container 

• Sorted By 

• Requirement ID 
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• RDD 

• Container Number 

• Drill Through Reports 

 

This report provides additional information via two drill-through reports: 

• By clicking on an underlined Booking Number, you will generate a Container Contents Report for 
all containers associated with that Booking. 

• By clicking on an underlined Container Number, you will generate a Container Contents Report 
for that container. 

 

Container Contents Report 
Purpose 
Lists all items within a container 

 

Drill-Through Parameters 
• Booking Number or Container Number 

If drilling through by Booking Number, returns all containers for that booking 

If drilling through by container number, returns just that container 

 

Layout 
Header 
• Booking Number 

• Carrier Name 

• Vessel Name 

• POD 

• Sail Date 

• Booking Status 

• Report Body 

• Container Number 

• Container TCN 

• Container Detail 

• Document Number 

• NSN 

• Nomenclature 

• Quantity 

• Quantity in Container 

• Sorted By 
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• Container Number 

• Document Number 

 

Container Status by Mission Spreadsheet 
Purpose 
Displays all items not received for a Mission 

Selection Parameters 
• Mission ID — You may select one or more Missions 

 
 

Layout 
There will be one worksheet for each Mission selected. 

Contents 
• Required Delivery Date 

• Booking Number 

• Carrier Name 

• Vessel Name 

• ETA 

• Sail Date 

• Container TCN 

• Container Number 

• RFID Tag ID 

• Van Size 

• Document Number 

• NSN 

• Item Quantity in Container 

• Unit of Measure 

• Nomenclature 

• Sorted By 

• RDD (most recent RDD first) 

• Booking Number 
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• Container Number 

• Document Number 

 

Container & Contents Receipt Spreadsheet 
Purpose 
Displays all items not received for a Mission 

Selection Parameters 
• Mission ID — You may select one or more Missions 

 
 

Layout 
There will be one worksheet for each Mission selected. 

Contents 
• Mission ID 

• Mission Name 

• Requirement ID 

• Required Delivery Date 

• Container Number 

• ETA 

• Received Date 

• Days Since Received 

• Booking Number 

• Point of Debarkation 

• Container Contents 

• Carrier Name 

• Vessel Name 

• Container TCN 

• Sail Date 

• Status Code 

• Requisitioner DODAAC 

• Serial Number 
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• NSN 

• Nomenclature 

• Short Nomenclature 

• Ration Name 

• Item Quantity in Container 

• Sorted By 

• Requirement ID 

• Container Number 

• Document Number 

 

Using the Crystal Reports Viewer 
After you have entered your report criteria and clicking the "Submit" button, Mission Tracking 
will generate the requested report and launch the Crystal Reports Viewer. The following topics 
discuss features of the Crystal Reports Viewer Toolbar that will allow you to view, print and 
export your report. 

 

Viewing Reports 
Use the Zoom control to change the scale of how a report displays on your computer screen.  

Use the Scroll control to see different pages of the report. This feature allows you to: 

• move ahead or back by a single page 

• move to a specific page or  

• move to the first or last page of the report. 

 

Printing Reports 
Click the Printer icon on the Toolbar to print a report. 

 

Exporting Reports 
You may wish to save an electronic copy of a report to your hard disk: 

• Click the "Export Report" icon on the Toolbar. 

• In the Export Dialog window, select the format of the file you wish to create. Options include 
Adobe Acrobat (PDF), Excel (XLS), HTML, Text and Microsoft Word  (doc). Reports exported to 
PDF will render the file as displayed in the Report Viewer, but will provide a limited ability to 
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copy data to external programs. Reports exported to Excel will also render the file as displayed in 
the Report Viewer and will be easier to copy data to external programs. 

 
• Select "Disk File" as the export destination 

• Click the "OK" button 

• From the "Choose Export File" window, Select a local drive on your computer from the "Save In" 
dropdown list.  

 
• If this is the first time you are exporting a file during your Mission Tracking session, the Citrix 

File Security window will appear. Select "Full Access" and click the "OK" button. This will allow 
the Report Viewer to access your local drives (i.e., C:\ and D:\ ). Note:  due to restrictions in 
Citrix, you will not be able to access shared network drives that you have defined on your personal 
computer. You will need to save the file to your local disk drives and then move the file to the 
shared network drive. 
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• When selecting a directory in which to save your file, please ensure that you have selected a 
directory on your local hard drive. Please note that your local drives will be named slightly 
differently in the Choose Export File window. They will be referred to as  "C$ on Client (C:)" or 
"D$ on Client (D:)". 
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Support 
For Support and Help 

To reach the SPIDERS Website Support and Help Desk, please call (781) 205-7222 or send email 
to spiders@northropgrumman.com. 

 

To reach the DSCP Mission Tracking support Point of Contact, please call Joan Lutz at (215)737-
9118 or send email to Joan.Lutz@dscp.dla.mil. 
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TROUBLESHOOTING 
Help With Citrix and Web Browsers 
What is Citrix? 

Citrix is a remote computing product which allows users to access server-based applications using 
a "Thin-Client" installed on the user's desktop or downloaded to a web browser such as 
Microsoft's Internet Explorer or Netscape's Communicator.  Citrix is used in the SPIDERS system 
to support a server-centric computing environment requiring little or no modification to the end 
user's platform. 

Using Citrix, SPIDERS applications appear as if they are running locally on the user's desktop 
when in fact they are actually executing on a central NT server perhaps hundreds or thousands of 
miles away.  From the user's perspective, the application looks and behaves like any other standard 
PC desktop application. 

Installing the Citrix Web Client 
Use the following instructions to install the Citrix Web Client for Microsoft Internet Explorer or 
Netscape.  

Note: Make sure you have the necessary privileges to install software on your workstation before 
continuing otherwise contact your system administrator and ask to have the Citrix Client installed 
for you.  

• Download the Citrix Web Client (ICA32T.EXE v7.00.17534) to a directory on your desktop.  For 
the location of the Citrix Web Client, please see "Help with Citrix Web Client" under Help on any 
SPIDERS web page. 

• Exit Netscape or Internet Explorer.  

• Run ICA32T.EXE in the directory where you saved the file.  

 
• Click the "Yes" button to begin the installation. 
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• Click the "Yes" button on the Citrix License Agreement  

 
• Click the "OK" button to finish the installation.  

• The Citrix Web Client is now installed. 

 

Help with Crystal Reports Viewer 
What is the Report Viewer Plug-In? 

Reports for SPIDERS are generated using a product called Crystal Decisions Crystal Reports.  
In order to view the reports on-line, a report viewer must be installed into your web browser.  
In addition to viewing the report on-line, the viewer has the ability to zoom in and out, print 
the report and save the report to your desktop.  Please note that this installation only needs to 
be done once unless you change or reinstall your browser. 

Installing the Crystal Reports Viewer Plug-In 
Note: Make sure you have the necessary privileges to install software on your workstation before 
continuing otherwise contact your system administrator and ask to have the Report Viewer 
installed for you.  

• For Internet Explorer browsers, just following the instructions when asked to install the Crystal 
Reports Viewer.  
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• For Netscape browsers, download the Crystal Reports Viewer Plug-In installation program to a 
directory on your desktop.  For the location of the Crystal Report Viewer, please see "Help with 
Crystal Report Viewer" under Help on any SPIDERS web page. 

• Run the installation program in the directory where you saved the file.  

 
• Click the "Continue" button to accept the default installation directory, otherwise use the 

"Browse" button to select an alternate destination directory. 

 
• Click the "Next" button to start the installation process.  
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! Click the "Finish" button to finish-up the installation. 

! Once the installation is completed, close and re-open your browser.  You should now be able 
to view the reports.  If you experience any installation problems, please contact your system 
administrator. 
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